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حق چاپ محفوظ است. 

همکاران محترم و دانش آموزان عزىز:
بـه نشانى  پىشنهـادات و نظرات خـود را در بـارۀ محتواى اىن کتاب 
    صندوق پستى شمارۀ    4874/15  دفتر تألىف کتاب های درسی فنى و  تهران 

حرفه اى و کاردانش، ارسال فرماىند.
tvoccd@roshd.ir پىام نگار)اىمىل(	
www.tvoccd.medu.ir وب گاه )وب ساىت(	

وزارت آموزش و پرورش
سازمان پژوهش و برنامه رىزى آموزشى

محتوای این کتاب در کمیسیون تخصصی رشتۀ کامپیوتر دفتر تألیف کتاب های درسی فنی و 
حرفه ای و کاردانش با عضویت: بتول عطاران، محمدرضا شکرریز، سیما سجادی، شهناز 

امین، اکرم راعی و سید رسول حسینی تأیید شده است.
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Create a new Presentation 

1- Click the Microsoft Office Button , and then click New.  

2- Under Templates, you see options you can use to create.  

3- Click the Blank and recent. 

4- Click the Create Button. 

Save your Office PowerPoint 2007 Presentation 

1- Click the Microsoft Office Button  and then click Save. 

2- The Save As dialog box appears. 

3- In the File name box, enter a name for your presentation, or do 

nothing to accept the suggested file name.  

4- In the Save in list, select the location that you want to save your 

presentation to, or do nothing to accept the suggested location.  

�������������������� To save in a new folder, click Create New Folder  . 

5- Click Save.  
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� �ID���Normal�� �J��Notes Page��� �K�Slide Show �� ���Slide Sorter  
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� �ID���V����,Close ��%4�����Office�������������
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���/%
������
c,M���

7- To save a new  presentation you: (Select all that apply) 

a- Select Open button on the office button 

b- Select Save button on the office button 

c- Select New button on the office button 

d- Press <Ctrl> + <F5> 
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�����.����������>%����� ��������G��� �Outline��6�.����(���Slides/Outline�.�(���U�������A�����������
 ���� ���-��A��C����&�����5��*- ����
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���5��>1��&���>.����� �� � ��� �� � ������ � �� � ���� �
A��K/� � � � ��(	C�� ��� ��Y(����� ��� � �� Ctrl+Enter ��� �����
���F:���'(.���� �� � ��� � �� �� ���� � �-L��A;����&�5�1� �� � �� ��� ��� ��� ���'()���� �� � ���3����A����� >��:��������� � �� �� � ��� �� �� �

������&���
������-L����� �� ���� �� �� � ��� �� �� � �� � �(	C������G�������8�����
��� ��� �� ����G�� � � � �� � �� �� �� � ��Y(���� Ctrl+Enter ������'()����K/� �� � ���� �.��

������� � � ����������
������� � ��� ������4���&����� �� �� ������-���� � ��.�������5��*-���� ���������� �� �� �Outline��

�� ����.��PowerPoint�C���J������� ��� � �����(��������������>.�D�� �����?�:�7��� ����-:������� ���� �(�0����I��>1���� ���� ���� � ���(���� ��3�� 
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�� 6�.���(��Slides/Outline&�����.����Outline	C�(�C�D(�M�3�FN1QPQR 
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�342�����

�� �]/����	:����6�.�(��Outline	C�(�C�D(A�N��������>.��>.���1�5����7�M�FN1^PQR3 

��
�342 ��� 

�� �$��Y�"Outline Tab"��������C�H� (	C�&��� (��� Y(����Enter _ Ctrl��)����K /�A� �U>)���� (��� �
MFN1�`PQR3�����6
����C(����-���C���6�.����5�1�H(��Slide.�(�>.�U���5����7����13��

��.���Outline 
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����(?&��A������-��H��������_���(1����-1����J����Y(�����Ctrl+Enter������ ()����K/����
����������1�4�����
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"���(,�����3������(	C��C�����
���Enter�����B�����������������
 ���� ()����K/��
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�� ��$��Y�����������C�H(�M�b�FN1cPQR 

This is a great place to start writing your content. 

�� 5��1��&�����d&����0�2>�������6�.�2���(�Slides/Outline )����I�(��FN 1���.�>)�����ePQ�
T�((������3 

�� ��T������_�((����5�� 1��FN 1�������A;��d&� ��� 0����������C�f���2 ����2> ��� ������ (����� �B��� �����6�.�� (��
Slides/Outline�U/����7�����3�]/�A��C���������>.��������-��7�6�.��(�������J&���3 

�� &���B-.����:;�����$��Y����	C��5�1�H(�C�D(	C�&��(��Enter)����K/����(�3 

��� ��$��Y�����������C�H(��3 

The Outline Tab shows your slide text in outline form. 
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���A�>)������8������/��-N.�A�1�3�����������(	C������������J���
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���������������� (Design Template) ��

�8?��6��"���(Design Template)h�"������)�5���;���������-*0���1BJ���F��I�7#���C����U J�������
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�������� ���

5��>1�E��&����(��������������8(A����$�>���������(6��"�A;����7�����&�(2���5�1�'�3��

���PowerPoint 2007  -I&����  >C�����OfficeU0�����  �New  ��[�  #-.��������C  (5�&�  L�����  C���� �
New Presentation��5�)�K����U0��C���1�����)�*	-#���������>.�2:�����J�7�-:�������� (����� I���

����)���C�������C�6�&&��+���A;����k?�>J����"����1���1;��)�M�FN1lPQR3��

��
�342/���1���;����5�New Presentation 
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• Installed Templates���)�8?��W�>��&��5�1�!�.��m��C�(�>.�������5����7����13 

• Microsoft Office Online��������)�8?��2>EI������F��I���� �����2/�����2������2/� �&�N
�-���������)����>.�@	-#����2���5�1�5����7�3���
����������C��1���5�1�F
&�2.�-�(��� ����

	C(�&��D���)���-������D����������I���)�������8?��2/������ ������ �.���� ������2���2/� �&�N
)��:(������3 

�8?��[�#-.���������5�&�L�����C�2����2>�������.������New Presentation���(�� >.�7��� 8?��7��
�����)��:�5�)�K��F��I�5�1�[�#-.�3��

����
������&���C������>C��Create�	C�(��>.�D(���>.������J�7�������� 8?��d���������������5� 1�[� #-.�������� �
�1��)��:3��

�����	�����>.������J�7��)�8?��d�������������(7��5�1��-:����

�� ����>C�� OfficeU0���� �New��[� #-.�������C� (��5�&� L����� C���New Presentation ��5�)�K ��
�����13 

	� U0����Installed Templates�C�[�#-.�����(���� )�8?��W� >��� ������&��5� 1�!� .���m�� C�(�����
�>.���1�5����73 


�� &����  N��  )�8?������	C���  J���  (�C�D  (6�.�����  ���  (�5�&�  L�����  C�2  ����2>  ���� �
New Presentation��(7��>.��C�5�)�K������"�����7(�3 

�� &���Create	C�(�C�D(��3 

�>.��J�7����8?��d����������#-.���������������13��

����������
� �
�����!(Themes)��

'���h�"���)��)��������(7��-:����������-E)�����>����C�����2.�/������i.����)���!?�I�&��)�������)���������n�����C�
��oJ(��)�S�2��
��������)����.�1����� .��������3�������� ����� J���� >��� ����� (�������� C�PowerPoint�� �������� "

�(7��
���p�/��������������)�(�*����(���2.�/����&����)�������?�>_��2?�6�&�5���.��������� >.���� ��7���� )��3��� ���
�>.�A��C�[�oJ���7���[�#-.�����A����N�'������
���������A;���)���C�+�>����3��
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�!9���:����
�� ���;�<��) =/>�"� �!�>���
)�	�����!
�	��
����� �?�&�>�<��) ���������������������������

��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!��
�B
���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���

�����[�#-.�����.��������'��DDesign��N�h�"������)��5&�0������J���Theme�C�[�#-.�� ���(��3�h�"
	C�������U�(
������)���>.����+�>���7�����1M�FN1qPQR3��

��
�3426��<7�=�>��	�(Theme)  

"����#$��%%&���!��	
���'%��()��*+�,��
�����������!"�#��[oJ����kK��>.�Z�)��
�����(��r�������Z��(E���(s�3����PowerPoint�����5&� 0����k��)��U���

Background�����.�������Design�������((T��Z����������2���5�1��-/�0���.�����)��
�����(���3���������C�����Z���
��.��� Design���U���2����2>������C�k�(�������&��A�N(��Z&�Background Styles�k ��5�)�K�������� 1

h�"�Z�?�0�����(�C�D(	C����Z�)�������7��>.���(��M�FN1OtPQR3��

��
�342�:������	?@	Background Styles�1�
�����Background  

5��1��A�������I����&����0d�D���)�Z&��h�"�������)7(��kK��>.k��5����7��>.���
������A;�������13��

����U0�Z&��D(	C���Format Background 5�&�L����C���k���)�S�Z�������5��*- ���� ��� C���� 0�� .������Z� )
k��A;������J���k0u�&��(	C�A������>.�'(�������7��>.���(������v�����Z�)M�3FN1�OOPQ�R��
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��
�342������1���;�����5�Format Background  

��.������Fillk��5�)�K��'(����������1b��

Solid fill������k-��s�i.�k��+�>���7��>.���(��������C3��

Gradient fill�k��+�>���7��>.���(���������$&�*-��i.��&�����kY(C������C3��

Picture or texture fill����A�����������Z������F��/�D��[�#-.���k��')��/�7��>.���(�����C3��

�����
�����i.���((T��7��>.���(����

�� �7��>.Example1.pptx�����+�w������CO����C���������(�C������3 

	� ������U ���2 ����2> ������(�������&��A�N(����Background Styles����Z�?� 0����&�� (�C�D (	C�
h�"��h�"����J���Z�)Style 5�(��U0������3 


�� ���U���Z&��5���&�Background Styles�D(	C��(������U0���������&�Format Background����
�(�C�[�#-.�3 

�� � 5�&�L�� ���C� ��Format Background� �.���� ���Fill� ���U0� �Solid�Z&�� &� 5��C�[�#-.�� ���
����U0�A�N(�Color��(��>.�[�#-.�������:�5��#?��i.��&��(�C�D(	C�M�FN1OQPQR3� 
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����� �?�&�>�<��) ���������������������������

��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!��
�B
���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���

��
�342��������A�?�Solid fill 

�� �'(�������5��*-�����Transparency�(�C�'(�������k��#-.����(���2(/�*1��3 


�� ��>C��Z&�Apply to All�������(��>.�D(	C����0�+�>����)��
���W�>��������#-.����(��3 

����������U0�����C������J����8���Z�)Format Background��(��>.�k�������3��

-����.�/0��12�3�+��4�5��(��5	
����!���

��������_���
������������.������$���%���4���&��)�(�)�0�����������������x�!?�y��A����+�,-.���-B����� :���2���W��

������J��)������J��-6����:�����������<o6��8�.�1�3�������<o6�����J�����J������D���
�����9����������-����� ���
A;���C�[�#-.������)3��

����	�������������� ��

�>.�����������.�������Slides���>.������!���������(Slide Sorter) ������[�#-.���
���D�&������A;�
	C(�C�D(��&�����
�����9�[�#-.������
���� ���
����C��2K���)��&�� ��-��� ���1���')���
������

	C�+&�(�C�D(	C��m��&��(��Shift	C��L*
����(�������(�&��&��-1����8.���
����	C��:;��(�>.�D(���3
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z� ��(�� ��	C�$��
��(��Ctrl	C��L*
����(��� ����(�&�� &��-1����8.���
�����)��	C���.������(�D
�C(�3��

	���	����!"#���� ��

��������������>.�D�)�0�7�:���2���W�x��
����������.�1�<o6��)���<o6���D�
�����9�����
A;�[�#-.�����������)�(	��Delete	C��L*
����(()����K/��������&����A;��	C��)(U0�&�5��C�2����D����

Delete Slide�C�[�#-.�� ���(�����.��������Home�0�����5&SlidesU0������Delete Slide	C����(�C�D(��3
M�FN1O^PQ3R��

��
�342� ����BC����D�E)	��AF������



��

!/��

�!9���:����
�� ���;�<��) =/>�"� �!�>���
)�	�����!
�	��
����� �?�&�>�<��) ���������������������������

��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!��
�B
���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���


���	�$%�&�'(&������ ���

����������Z�>.�����7��>.�D��Z�)��
���A��C�kmCSlide Sorter�&�5��C�[�#-.�������.��������
���
����.������Home������U���Z&��Copy����5&�0����Clipboard���D(	C����(�CM����(	C���Ctrl���������(�� ������ (	C��L*
����

������(	C�&��-1����8.C����()����K/�����R��������������5&� 0����&�5�� ����.������FL��������d&����m�Clipboard��Z&��
����U��Paste���(��>.�D(	C�M�3����(	C���Ctrl��������������� (	C�&��- 1���� 8.��(��������(	C��L*
����V������ ()����K /����R�

M�FN1OaPQ3R��

��
�342�!�����1�
�Clipboard�

�����	�)�*+�$%�&��*������ ���

��J����Z��
����()��#���=.��9���Z�>.������(�C��JSlide Sorter�����&�5�� C�[�#-.�������.��������
���
���.���Home������U���Z&��Cut����5&�0����Clipboard�����(�C�D(	C�M���(	C���Ctrl����� 8.��(�� ������ (	C��L*
����

�����(	C�&��-1��X����()����K/�����R�����5&� 0����&�5������.������FL��������d&����mClipboard����U ���Z&��
Paste��(��>.�D(	C�M��(	C���Ctrl��(	C�&��-1����8.��(��������(	C��L*
����V�()����K/����R3���

6���7�������
�	
�����!���

���
����C���.;��������?&��d��������)����A;�2:���2���>.��)�����5����7���)�0����1���������,-.������&�j�%����-B��+
���>.�!?�y��W��E.�����
���2���W�x��7�����J�����)�����C��J('�3�����!����������
�����5�����)���� �����{&���

�>.����5��*-���!�������� ��(Slide Sorter) � ��J�&����� J���
 ������{&��D >C�� ���)����� )��&�A�(K ��
A���(Drag & Drop) �2���3�>.�����-Y?��������(Normal)��.�������Slide� ��')���.���� (���� �������� C��

�)��W��.�(��3�����
�����������
������_���C���)����>.�����7�������������� C���.;������1������ �����
 ����� >.����)���
�->C�������������2���5�)�K��F��I�A��U>)���"�!���������
��������A� ���� ���)�� (�-K�.�� ()��:���� (��
21���M�FN1OcPQR3��
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��
�342�"����-��+G7
�����)+�(Slide Sorter)  

��������A��������>.��
���4����7�!�����A;����������
���<o6�&�����

�� �>.��7Example1�+�w������C����O���������6�&�������� ���D��� 1���My Presentation Files�
-:��(��������C(�3 

	� ��.�����Slides6�.����(��Slides/Outline&�����:;��
������	C��(�C�D([�#-.��������1�3 


�� ��.������Home�5&�0����Slides&�����(�� �����&��A�N(���� >C���New Slide	C�� (�C�D� (��� ���
?(9�2E(A�����)��>.�5�)�K�����@	-#��(���3&��9�(�A���Title and Content 	C�(�C�D(��


�������J����������1�����3 

 



��

":��

�!9���:����
�� ���;�<��) =/>�"� �!�>���
)�	�����!
�	��
����� �?�&�>�<��) ���������������������������

��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!��
�B
���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���

�� 5�.���B8.���Title A����� Slide Sorter View&�5�.���B8.���Content ���-������(�C�H�������3 

�Slide Sorter view is a view of your slides in thumbnail form��
�� ��.������Design'��Equity �C�[�#-.�����(�3 


�� �>.��>.���"�������7���.����|View�5&� 0����Presentation View ���2 ?�6�� ��Slide Sorter �
�&;����3 

�� 
����:;�A�N��������+&����
���������C�F,-�(�3 

8��.����������9��

��������_����-���N�����
��������������C����&��������)��#��2 ���� N>���� (���T�����A;��� ((�)���� (��K #���������A;����
��<o6��Y?�y����������/�%��A;�����(���3������������	C���.������FL�������-��A��C��/�%��(�����J��-��&�5��C�D���

�������C�H(�3��

��&����FYI������7��������A;�2���W�x��-��D���C�[�#-.���(��3��� ��������{&������- ��[� #-.����� )����� ����5��*- ����
�����1b��

• ��!�#�,����������A�N������>.���������-������)�����I�<�6�(�	C���(���Shift��������(�����&��- 1����8.���
	C����5��*-�����(�)��A�N�����.������<�6���>.��C�[�#-.����(�3 

• +�-&��������&���	C�F�����>	C�(�C�D(�3 

• �+-�*�����������0���I������(���A�N����&���>.����	C��� 	>J�� (���Ctrl�� �����(������ ��&��- 1���� 8.��
	C�d&��(�C�D(��3 

• !��.�/�0���������&��')����2K���������	C�<��0�����(�C�D(�3 

• 12�3��� ������� 45�������������.�������Outline 6�.����� (��Slides/Outline�
 ���������
��-����
��������B-.���������C�f���d&���(�3 

• ����6�����������	C�(&��D�	C���-��5�.���B8.�(&��D�� Select��5&� 0���Editing��� .�������
HomeU0�[�#-.��&�����Select All��5�.���B8.�F:����-��FC�[�#-.��n��������13M���5��*- ��

	C���(��Y(�����Ctrl+AR 
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����������-��[�#-.������_����J��U8�����J��-��A��C��/�C����� �����2A;��������� ���C�H� (��3��� ��������- ��<o 6�
	C��L*
����5�1�[�#-.�(����(	�Delete )����K/����(��3����	L������-��+�,-.����J���� >C��������� )��

Cut�Copy �&�Paste.�!E6����(�5&�0�������Clipboard��.�������Home�C�5��*-���(��3��

���
����T���T?���-���:��C(($��5�1�5�����(-E)�������� ��-�����U ������ .���� ����}(Quick Access)��
��&��>C�Undo ��(����(	�3��

:�� '����
�;�<
�;��=�>��	
���4�����

����
�������-��4����5�.���B8.����5��*-������5&
��������)���-�����C����A������C�5��*-����3���������
��.������������Insert5&�0�����Text�&�����>C��Text Box	C�(�C�D(�]/�����m�����?�:��
������

��d&���A��C�f���������-�����C�����:�5��#?��5���.�������C����(��3��

������ � � ������&��D(	C�����_���C�����
���Text Box���������������?� :���] /�D ������ B����d&� ��f����� J
A��C��/�%�����������C��(�C�D(	C���
�� ����������-���������- ��A;����� C���1����� ����� I�V :�D ����&��� (0

����((T��A;�5���.���-�����!���-������3 

�����-�����C�4�������_����������-�����C�&�5�1�+�_/�4����8.�K.�������� 9�V:�FN1����(�� �������;� ����������� C��� ���
2?�6������-��A������������C��/�%�����C����������&����A;�F:����-����������>.�7�3��KC�������>%��� � ����G��� �(�8-���A�(5���)��

�����C������J����T��5��#?��������A;�5���.��A���((����� M�FN1OePQR3��

��
342��#���A������5����

�=>)(����A�N��A�������I�������&���>.��8-���(����� ���i .��UY��5�������� �-����� C�A�� ����������@ 	-#��$� BJ�� �����
�.�:�93��

��8-(5���) 

8-��(�5�7:�9 
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�	��
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��	����)	�0����@�������;�������������������
����A>����������������������������������������0����	����)	��!��
�B
���;�/�������

1��-2��CDEDFCDCF=G�����������������������������������������������������������������������������1��-2�EDEDEH=2�=I&������

� ���

?���&��%%@�AB��%�C�D+�=��

����T��((
��:��(�)�S�FN1�$��-.�/�����2���5�1�+�>����-������C���� .����Home�5&� 0����Font ��
&��������.������>C�������&����(���������&��A�N(�����������&�5�����(	��A;��������U0������.����������(���[�#-.�����
M�FN1OgPQR3��

��

��
�342�$����1�
��Font���

������ � � �������1����2E(?����5��*-������5&
�Font Size������ ���2 .�/�5��� .��7)� C�� ��7��U/�������������A�� �
)��U���2.�/�5���.��7��U/����(Increase Font Size)&� �2.�/�5���.��7)�C(Decrease Font Size)��C�5��*-���3 

���������T�((
��:��(�-��$���

�� ��>.�D�?�:�7�����C����(��3 

	� �
�������?�:����������-�����C�D����C��/�%��(����$��Y��&��"�.����������������U/��W�.������C����! 	y���"�����
����C�H(�3 


�� ���.��5&�0����5��*-���������2.�/�5Font��.�������Home����^Q T�(()���(�3 

�� �������2.�/B Nazanin�Y���	C����&�5��C�F(&��D���(������&��A�N(���Font Color��-��i.��
����;�i.�����T��(()���(�3 

�� �����-�������C�[�#-.�����5�1�H(���	C����&��(�&��D����(���������&��A�N(���� �����>C���(���] /�'��� ��(��
CU0��)�-C��������)��C�A�L-�������A;�@	-#��(��M�FN1OlPQR3 
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T�((2.�/�5���.��� 

�U/��2.�/�5���.��7 
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��Paragraph 
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��������!��G4���WordArt����H4���������HI5�J�H*K����H!��

G�+�=�������4���

����5�	J�+�>�����)�U-.�/����.��������-�����Format��5&�0�WordArt Styles�C�[�#-.�� ���(�M� 3��J��
1����-1��(��.�����Format.�������-���F��I��A�N���C�2����&���>.����-�������D��1���3R��

&����(��A�N������&(�����1�0�����C��(��5&�0�2����2>���WordArt Styles��5�)�K����	C����1(�D
�?�0����&�5��C�5�	J���)����J����N��C�[�#-.�����(��3 ��
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������ � � �������?�0WordArt2���7#��&���������3�7#����Applies to Selected Text���5� 1�[� #-.��5�	J�
5�1�[�#-.���C�<��0���������K#������B�����+�>�������1&��7#�����Applies to All Text���-��<��0�����FC����

�+�>����� ����13 

2>EI���Text Outline T��A�N���((��')��/�5�1�+�>����-�����2N/�����)��:����I�&���1(���i .���� ���
�T������-���&��v�y:�j�.��((��)�(�3��

��>C�����5��*-�����Effect�5&�0����WordArt Styles�����5�	J�A����)�����������.������(Shadow)��
����[���������(Reflection)�8-:&�/����2?�6���(Glow)�_�����7:�9����(3-D Rotation)T��&�((��
���)�FN1��(Transform)���C�+�>������M�FN1QtPQR3��
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�342�:����1�
��Word Art Styles  

�����
��U-.�/�5�	J�A��������&��-�����(��#K��'<��0�����$��

�� �>.��7Example1�+�w������C����O���������6�&�������� ���D��� 1���My Presentation Files�
-:��(�������C�(�3� 

	� �:;����
������A������Outline Tab�C�[�#-.�����(��� .�������5��*-������&��Format���5&� 0����
WordArt Styles&�����(������&��A�N(�	C��(�C�D(����8.����&����&��d&� ���- 1��)�� �����D

5�	J�A;�W�.��)��C�5�)�K������)(�3 


�� �7#����Applies to Selected Text�5�	J��Fill-None, Outline-Accent2�C�[�#-.�����(�3 

�� &����(������&��A�N(��Text Outline 	C�(�C�D(�������&������ �;�i .��5� 1��������[� #-.�����
�C(�3 

�� �7#����Content[�#-.�����<��0�������������&�5��C��V�&��� 9(� �5&� 0������Paragraph ����
�.��� Home �C�[�#-.��(��3 

 

Text Fill 

Text Outline 

Text Effects 
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����������(Slide Master)��


����8?��� (Slide Master) 
������
�:������-*0����8?���C���1�	
���
���W�>����)������5�1����
��>.�����2���7�3	C(�����%�������
�������C�����8?����.�1���������
���W�>�������C��:���"��5�)�K���)�

�����1�3��
������5��*-�������-6������5&
���8?��������n������C���������� N��$��� %���A�1�A�EN������d��;�F w��
��>C���W�;��)����������&��&�����YI��(���
���FC����F��)����>.������������ �����> %��� 1�� )��:�7�������������� � �G��� � ��� � �� � �� � ����T��� ((����F C�����


����/�C��)����������������.������j�%���2����
������T���8?���((�)���(������
���FC����j�%���A;�������T���)�((��
��C�3��

���PowerPoint 2007�>.��)�������7������8?����
��2���b��

�� Slide Master�������>���7#������������D����9��Master��2���� >.��C���)� S����F L���
0���I(��1��(����&����������(
���W�>������)���>.��_�����7((�������C3 

	� Handout Master������Master�>.���)�S��
����_��~�9�W�8�)��������)�((�������C3 


�� Notes Master������Master�>.���)�S�����0�21�����_�����5��((�������C3 

��� ��� ��-������� ��Slide Master��� .�������View��5&� 0����Presentation Views&����Slide Master�
	C(��C�D(��3�6�.���(���Slides/Outline��9�W�>��(A�����)��Master�����5����A�K.������ 1�3� ?&�(�9��� (�A���
�>.��Slide Master	C����(9��(A�����>.�����)�T���)�&�2���v�����7((	C����A;�����(9��(A������ )��
�>.����+�>���7���1�3?�6����9��C�(A�����)��_����C�[�#-.������ (�T��� )���� ((���! J���� B���A;�����

��((T���
�����)����>.�������7��9��C���1(.�����.�������K���MFN1�QOPQR3��

��
�342������1�
��Presentation Views��

������ � � ������>.��&��D(	C����Slide Master���W�.��������J��.���Slide Master�H9�2>�����Home��/�%��

�����&��D(	C�����C���1Close Master View���>.����Slide Master��4��:�������1M�FN1QQPQR3 
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�342���������@��Slide Master 

��������T��&�5�)�K�((
�������8?��� 

�� �>.��7Example 1�C��������(�3 

	� ��.������View�5&�0�&�Presentation Views&����>C��Slide Master 	C�(�C�D(��3��������C��
��.���Slide Master��.����H9�2>����� Home���/�%������13 


�� �����&��5�����H9�2>�����?&��(�
������	C��(��C�D(��3����
 �������	 
������� >.��������� )�&�2 ���7
T�((����A;�����C���C����(
���W�>��������1��)��:�+�>����)�3 

�� ������(��
���������7#������Footer���$��Y���"���{�&���&�{���;�$���&"�����������C�H(��3����������� C��
��
���W�>�����$��Y�����)���>.���>���7�1��)��:�+3 

��

������������	
����

WordArt Styles 

WordArt is a gallery of text styles that you can add to your 2007 Microsoft 

Office system documents to create decorative effects, such as shadowed or 

mirrored (reflected) text. In Microsoft Office PowerPoint 2007, you can also 

convert existing text into WordArt. You can change WordArt text like you 

can change any other text in a shape. 

Slide Master: Slide master is part of a template that stores information, 

including placements of text and objects on a slide, text and object 

placeholder sizes, text styles, backgrounds, color themes, effects, and 

animation. 

The following picture shows a single slide master that contains three layouts. 
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� ���

�L�.����+��
Apply A������C�����

Background �����(����
Character Spacing ���	
�/(�)�-C���C����
Design k6��"��

Drag &Drop KC(�-:��.��&�A���
Edit &����7��

Footer �L*
����
Header F�/�����
Home �.�:��

Picture �������
Slide Master 
����8?�����

Tab �.�����
Text Box k�-�����C��
Theme '��� ����

Title�� A������
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• ���PowerPoint�  >.�A�  N����Z�  >.���  B9����7Normal �Slide Sorter ��Notes Pages&�� �

Slide Show�������J&�3 

• �>.�Z�>.�
���7���(Slide Show)�����������>.����5����Z&��A�Y"�#�����7�
���>.��L*��7
k��5��*-�����13 

• ��.�������5&
�Slidesk�����.�������A���Outline.�(
���U�����/�%��&�������7���3 

• 	��I(����W�.����k-Zoom��21���A�N����������������������
 ���F :���$��� %���A����A�K.���U�����')�� /�����
k����C3 

• (9��A���MLayout�R�
����)���0���I�FL����� (�� 1��Z�(�������#K �����A;�F :���Z���k ����� �C�3��� )
9�(�5�.���B8.�Z���_��Z�����A��MPlaceholder�R2��3 

• �k6��"�Z�8?�(Design Template)h�"�����5���;�Z�)��Z�����-*0��kBJ���F��I�7#���C���1
����Z�UJ������>.�D���YI����7�i.��F(�(�������W�/���)���B8.�J�j�.�&����_��������A�-��k)�?��� (2E���Z� )

2�
���������5��>1������Z��(E��&������������������8(�A����$�>����� ������� �(������� ����&�k 6��"�A;����7(�'
2���5�1�3 

• '���h�"���)��������Z�)(7��-:���������>����C���-E)�Z����2.�/����Z���i.����)���!?�I�&��)��Z� ����������� )
�
���Z�)�S�2(��oJ�n�����Ck���)���.�1���.�������3��

• 
��:��"����<��0�����&�2.�/�$�(��.����|HomeT��F��I�((E)����-3 

• �Z�)��U��WordArt 5�	J�+�>���A�N����k��')��/�����-�����ZU-.�/�Z�)���&;3 

• 
����8?���(Slide Master) 
�������k���-*0�k
�:����
 ���W�>��k	
��Z�8?���C���1��Z�)�
���>.����5�1�����2���73 

��
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� ���

�N+�<���O���
�� 1��+�&%�6� &�7��%�&�8%�9����14���/%�&�,��$%�&�%/�:�;��)�$�3�< 

=2����WordArt� � ����Text Box��  � �>��Smart Art� %���Book Mark 

	� 1��8%�9����+��)7�6� &�7��?�3@�87� ����AAB��;��)�<%3C 

� �=2���Format�� ����Home���� �>��Insert������� �%���View 


�� �8:�.Themes<?���+��)7�6� &�/%� 

� �=2���Format������� ����Home��� �>�Design ��� �%���View 

�� Handout Master1��6�D���;/�&�+5��< �% 

� �=2��_��((�>.����)�S��
�����~�9�W�8�)��)���

� ���_��((�>.����)�S�����0�21���������5�� ���

� �>�_��((�>.����)�S��0���I�FL��&�(��1��(����&����������(
���W�>������)���>.������7��

� �%��_��((9�5�L.��(1��A���(
�����������

��  &�7��3E2�� �������F)�;��)1��8%�9����+4�G.�6��<%3C 

� �=2���Close��>C�����Office��������������������� 

� �����>�� Close x������5�������

� �>��Close Master View�.�������Slide Master  

� �%���Y(�����(	���Alt + F4��


�� '��+��)7�6� &�7��8%�9�����)�<%�%��AAB���/� �����+4A�7�H0�I�/�$�3� 

=2���Format������� ����Home��� �>�Design ��� �%���View��

7- Which one is the best view for organizing your thoughts on a presentation’s 

content? 

a- Normal View ��
b- Slide Sorter View��
c- Outline View 

d- Notes View 

 

 

 



��

#���

��

�7��8�����-����1(�J
�/�����PowerPoint 2007�������

����	97��������������;�����
� �

��

I*K�<���O����
�� �>.��J�7�������C����(��3 

	� )��#?��'��&�������>.���>���7�C�+(�3 


�� 
����J��������9�&�5��C����(�������A;�A���Tow ContentT��(()���(�3 

�� .�������������������.�������5��*-������&�5��C����&�A�����5�.���B8.�������Format����������5� .���B8.������J����-���
!?�I������C�(��3 

�� 
����J�������(
�������W&��&�+&�����C����(�3 


�� ��%���#-.��5��#?���������C�[�(
���������&��������C����C�����������������C�5���;��(�3 

�� �����(����(�C�+�>����)��
���Z&��@	-#��i.��&�����!C���Z�3 

�� �>.�K�5��C�5���;��C����������>.�����Slide Show ���
 ������&�5�� C��� J����)������� J���(�� >��7
�C(��3 

�� �������_���>.�������J��A���>.��&�5�1�4��:�7�>.�����������(Normal)��0�����3 
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�� �����������	�
���
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��������� 

�� �����	��������������Clip Art���������� 
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Change the data in an existing chart 

If you create a chart for your presentation and then the data used in the chart 

changes, you can update the data so that the chart is accurate. 

1- Select the chart that you want to change.  

2- Under Chart Tools, on the Design tab, in the Data group, click Edit 

Data.  

Microsoft Office Excel opens in a split window and displays the 

worksheet that you want to edit. 

3- To edit the contents of a title or data in a cell, in the Excel worksheet, 

click the cell that contains the title or the data that you want to 

change, and then type the new information. 
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5- You can edit or format a chart object using any of the following methods, 

except…. 

a- Double-clicking the object. 

b- Right-clicking the object and selecting Format Object from the shortcut 

menu. 
c- Selecting the object and clicking the Format Object button on the Chart 

toolbars. 

d- Click the chart Object list arrow on the Chart toolbars and select the object. 
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Rehearse  

You can rehearse your presentation to make sure that it fits within a certain 

time frame. While you rehearse, use the Slide Timing feature to record the 

time that you need to present each slide, and then use the recorded times to 

advance the slides automatically when you give your presentation to your 

actual audience.�

• The Rehearsal toolbar contains: 

��

1- Next (advance to next slide) 

2- Pause 

3- Slide Time 

4- Repeat 

5- Total time for presentation 
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�Custom Slide Show�

�&����5��
����� ���

• �
����5��
�������4�Set Up Slide Show���,"����Slide Show��&��
��
	������7���
�'T�S$'�

��G�j
��	�r!D�
	������#$%�
���'���[&
�����,;�,;� ��

• ��"R	�Package for CD+���9�k��
�]�(����
��,#	��,'��U&�4����
	���������-&��
)-(
���-�'����<


	�����	
�
��
,������+�&�T%
,G��*O8&���%��������$4�  

 

 

 

 

 

 

 

 

��

��



��

�����

�%$��(&����*������0�1��2�3�,�4���%�,���*2�����"�%*������������5�!�,�1��2����������������������������

	����(	�/������6����	��0�"�������7,���������������������������������������������������������	����(	�/����%
�*�.*���0����
����

0��,1��89:9;898;3<�����������������������������������������������������������������������������0��,1�:9:9:=3>�3?!������

� ���

"-
 �	��!
 

�� �>��%�;<=!�:!�?!@$�%A���A%�B CD Transition to This Slide (��E!�����'F'G���%�F 7��#F$�

������HI�(9�� 7�#>�A�J�K'�����!�?�&7!�@7�L�����>��$K'�MN�����

� �OP!�Slide Option  � �� �Q��Slide Setup��

� �R��Modify Transition� �%���Slide�Advance��

	� (���%�;<=!�# $%�?!@$�:!�@�S=!�K��E%�$�(;T��I!�>�M%�L 

� �OP!����4��Set Up Slide Show��������� �Q�����4�Slide Show���

� �R����4��Hide Slide �� �%������4�Rehearsal Timing 


�� *��+�RA%�I!�>(���%�;<=!�#U�V��?!@$�:!����'W��$�KC�%%A�H�I�A�:!�(��)��M%�L 

� �OP!��Insert > Sounds > Sound From Clip Organizer��

� �Q��Insert > Sounds > Sound From File��

� �R��Insert > Sounds > Record Sound��

� �%���Insert > Sounds > Play CD Audio Track 

�� X�:!�(LA�;=�I!��!�K��BY�=�I!�>(���%�;<=!�IA!V>!�#�M%�L��

� �OP!�Custom Slide Show ���� �Q��Set Up Slide Show��������

� �R�Hide Slide ������� �� �%���Advance Slide��

5- How can you insert a movie into a PowerPoint slide? 

a- You need a video camera and USB cable. 

b- You need to buy Microsoft Movie Maker. 

c- Click the Media button on the Office button. 

d- Select Insert >Media Clips >Click on Movie Button 


���@'H%�Z�L�!A�A!���?�[;�\ 

���# $%�%�$A�$��H@'H%�]'.���!A�(��'� "�I\ 
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� �(
���Slide Sorter� �)��Slide Show� �*�Notes Page � �����Normal 
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���Esc� �)��Enter� �*��Enter + Ctrl� �����F5 
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� �(
���Theme Colors��������������� �)��Pure Color and white����

� �*��Background Style����������������� �����Effects 
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���Shapes� �)��Symbols� �*��Text Box� �����Quick parts��
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���Slide Master� �)��Handout Master�*��Note Master� �����Slide Sorter��
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���Table Style� �� �)��Borders��

�����*��Rows & Columns� �����Delete Placeholders��
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� �(
���Animate� �� �)��Transition Sound��

� �*��Custom Animation� �����Transition Speed��
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19- Which of the following is a way to cut text? 

a- Select the text and press <Ctrl> + <X>. 

b- Select the text and press the delete button. 

c- Select the text and select Copy on the Office button. 

d- Select the text and press <Ctrl> + <V>. 

20- Which of the following is Not one of the PowerPoint’s views? 

a- Normal View 

b- Presentation View 

c- Slide Show View 

d- Slide Sorter View 
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1- Office.microsoft.com, “PowerPoint home page” 

2- Microsoft Office PowerPoint Help. 

3- Kapoun,Jim. The Use of PowerPoint in the Library Classroom: An Experiment in  

         Learning Outcomes. Library  Philosophy and Practice, Vol. 6, no. 1 (Fall 2003.) 

      Available: (www.webpages.uidaho.edu/~mbolin/lppv6n1.htm)�

             ISSN 1522-0222 
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